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How do | follow my course?

To learn how to do the course you must click on the flag of your country in the
‘Welcome to...” of your course, where initial indications are given.

Welcome to Az.I1

Here you will find instructions on this course and the resources available
to you in this platform.

We recommend that you study one unit a week and follow the order
proposed here to take full advantadge of your course.

Have a great learning experience!

IMPORTANT: When you write a sentence in a gap, if you are going to use
the contracted form, remember to write an apostrophe (‘) and not an accent
mark (*). Also, do not use period (.) at the end of words and sentences

you write.
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FAQs (FREQUENTLY ASKED QUESTIONS)

What kind of course do | have?
You can have one of these courses:

- General languages (English, Spanish, German, Chinese, French)
- Professional English (medical, tourism, business)
- English exam preparation (PET, FCE, CAE, TOEFL)

Each of these courses has its own characteristics, so, once inside, it is very
important to consult the first section called ‘Welcome to...".

Can 1 change my level?

Yes, you just need to send an email request to the following address:
tutoriasonline@cambridgeinstitute.net

In any case, we recommend trying the course within the first fifteen days from
the starting date to ensure you are at the appropriate level. If you need to
change your level, either to a higher or a lower one, you can only request a
single change.

I enter the page New Cambridge Institute Online Courses,
I put my username and password, but I get an error. What
can 1 do?

Verify that your username and password Log in
are exactly as those sent in the electronic

welcome mail. In case you still cannot

access your course, you just need to send Username

an email request to the following address:

i . . i . X Password Log in
tutoriasonline@cambridgeinstitute.net, or click
on the link ‘Forgotten your username or @ Rememberusername
password?’, which will respond automatically [Forgotten your username or password?]
by telling you how you should change your
username and password. Cookies must be enabled in vour browser ()

Emails received after clicking on ‘Forgotten your username or password?’
may come to the spam folder so it is advisable to also check this section
of your email account.
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We recommend you accept cookies from our website

“Cookies” are pieces of information that are stored on your computer and
are used by the browser and the servers of pages visited in order to preserve
information from one page to another. On the platform, “cookies” are necessary
to remember your user name in the browser and to keep the service running
between pages. When you leave the platform or close the browser this cookie
is destroyed. How to enable cookies in some browsers:

1. Windows Internet Explorer — go to Tools > Internet Options >
Privacy (verify that it is marked on Media).

2. Windows Firefox — Go to Tools > Options > Privacy > Cookies and
Accept cookies (verify that the site is marked).

3. Windows Chrome — Go to Settings > Privacy > Content Settings >
Mark Allow local data to be stored.

4. Macintosh Safari — go to Safari > Preferences > Privacy > Cookies
(verify that ‘Accept Cookies’ is marked).

Go to page 20 of this document (to the section called ‘Suggestions’) to
configure cookies depending on your browser.

Can 1 do the course from my Smartphone or Tablet?

Yes, our courses are designed to be done from smartphones and tablets.
However, it depends on the type of exercise.

Example: ‘Speaking’ and ‘Drag and Drop’ exercises must be done directly
on the computer as they require Flash.
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I entered the Cambridge Institute New Online Courses page
and put my username and password, but should I install any
software?

All you need is to have Flash Player and JavaScript enabled on your browser
or installed on your computer. Do not forget to restart your browser and your
computer after performing installation so changes are saved (we recommend
to use the latest versions of Flash Player and JavaScript). Download Flash
Player and JavaScript by clicking on the respective links:

ADOBE {;
FLASH PLAYER i
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-[g' Adobe - Install Adobe Fla- %

<« C [ getadobe.com/flashplayer/?no_redirect

Step:1of 3

AdObe Fl.aSh P[ayer Optional offer: Terms & conditions:

Dvesj install the free McAfee Security By clicking the "Install now™ button, you
Scan Plus utility to check the status of acknowledge that you have read and agree
my PC security. It will not modify to the Adobe Software Licensing Agreement.
‘existing antivirus program or PC
settings.

T McAfee® | Security Scan Plus

Note: Adobe Flash Player i already installed, but
disabled. Click here for more information. Learn more

Version 15.0.0.189
System requirements

Your system:
Windows 64-bit, English, Chrome
Need Flash Player for a different computer?

Note: Your antivirus software must allow
you to install software.

Are you an IT manager or OEM? Install now

Total size: 17.09 MB

When you install, uninstall or upgrade Flash, (whenever Chrome asks), please
mark: ‘Always allow JavaScript on elearning.cambridgeinstitute.net’.

|i JavaScript was blocked on this page.

(8 Always allow Javascript on elearning cambridgeinstitute net

Continue blecking JavaScript

Manage lavaScript blocking... Done

— SR g = R T Rt ST

If not, check the following page which tells you how to enable Java in each
browser. Just search the one you use.

http://www.enable-javascript.com/
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Can 1 see units if 1 access the platform from different
computers?

Yes, you can. But you must be sure to leave the platform once you have
finished. The student just needs to click ‘Logout’ (at the top right of the initial
window).

I completed the first unit of my course yesterday. Now, I
want to go back to that unit’s exercises, can | access itagain?

Yes, you can. All you have to do is to access the corresponding unit. All automatic
correction exercises have unlimited attempts, while for ‘Speaking’ and
‘Writing’ exercises (corrected by your tutor) you are entitled to 5 attempts.

Unit 2 - This is Hong Kong

UNIT 2: THIS 1S HONG KONG
‘h Hong Kong

n "Around the world"
(E) 1 Pronunciation

[E) > Should vs. Have to

. "Around the world"

Who corrects my exercises and essays? How long do | have
to wait for the correction?

All multiple choice questions are automatically corrected by the system and you
can verify the correct answers immediately. Open questions such as ‘Speaking’
and ‘Writing’, are corrected in a personalized way by your tutor within 24 hours
- 48 hours.
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Why is the answer marked as incorrect if it is same that the
system gives as correct?

Probably due to the use of accent instead of the apostrophe or the use of the

endpoint, quotation marks, exclamation mark, etc. (please go to the ‘Welcome
to...” tab for more info).

Question 2 Exercise 1:Fill in the blanks with the following verbs in the present continuous.
Not yet answered

Marked ont of 7.00 visit|read|play|eat|get|drink|swim

v Flaz question
1.- A:"Where's Tom?"

B:"Oh, he's at a friend's house. It's hot today, I think they're 2

Why is this message displayed at the end of the exercise:
“Not Graded Yet”?

Because these exercises are manually corrected by tutors within the next 24-
48 hours.

Started on Thursday, 23 October 2014, 11:44 AM
State Finished
Completed on Thursday, 23 October 2014, 11:45 AM

Time taken 18secs

Grade

Information " . x . .
Josh has written you a letter detailing some health problems he has had since travelling. Read the letter and answer his requests, based on what vou have
Ela i g
Y i learned in this unit in about 150 words.

Information

v Flag question
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How can | see the ‘Listenings’ script?

You need to click ‘Audio Script’ as shown in the picture.

Information

 Flag question

4 Edit question

Question 1

Not yet answered
Marked out of 1.00
\p Flag question

o Edit question

I cannot see the text of the audio script. What can | do?

Chances are you probably have activated the popup blocker in your browser.
Please disable it and try accessing again. Depending on the browser, a yellow
bar or icon on the top or bottom of your screen and a message in the toolbar
(such as ‘Google Toolbar’) may have appeared. In this case, you must allow
popups for this website. Otherwise, locate the settings for this feature in the

CEFR English Levels » Bo.II » Speaking - Pet peeves » Pre

Audio Script || ———— ————

Instructions:
You need a microphone to do this exercise.

Listen to the speakers again and practice your pronunciation.

Click on the script above, so vou can read it. Choose one speaker and recd||

Click on the red cirele to record your voice. .

browser you're using.

-I0-2-Listeni

[ elearning.cambridgeinstitute.net/course/pluginfile.php/374/question/questiontext;

Listening — Pet Peeves

Speaker |: My biggest pet peeve is when people are driving and
doing something else at the same time. There are so many things
that are important to pay attention to on the road, it is very dan-
gerous to be doing something else. Whether it is talking on a
maobile phone, doing your makeup, or actually trying to READ
while driving, it is something that really bothers me. | wish
people would pay attention more!

Speaker 2: | can't stand it when people talk in the third person.
It is definitely my biggest pet peeve when someone says, for ex-
ample, “Mark doesn't like that,” when they are talking about
themselves. ltis like they think they are better than other
people. Once, | did this on accident, and thinking back on it, |
wish | hadn'e said it. It made me look like a hypocrite.

Speaker 3: The thing that bothers me the most is when my hus-
band uses the toilet and forgets to put the seat down. Itis sucha
big pet peeve when | have to remind him that | have to sit down
to use the bathreom! When he says he is sorry, he is sincere
about it, but | wish he would listen to me more often.

Speaker 4. My biggest pet peeve is when | can’t remember where
| put something. Every week it is either | can't find my keys or
my cell phone or something like that. It is really frustrating be-
cause | think when | put them away | never thought | wouldn't be
able to find them. | wish | wasn't so forgetful.
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How do | record my ‘Speaking’ and how do I send it?

To use the recording and upload an audio file you must find the ‘Recording’
exercise you have in your course units.

Once here, you must click on the red circle (‘Record’) to start recording.

@l [ mp3  Time: 00:00 E"‘E
| i

Then you click on the white square to stop recording (‘Stop’) and the file is
automatically sent out showing the next message ‘Uploading’.

If you have not used the microphone before, you may have to allow ‘Camera
and Microphone access’.

In the Chrome browser, Adobe Flash Player will ask you to allow ‘Camera
and Microphone Access’ with a pop-up window, in which you must click

‘Allow’ (if this message does not appear, your microphone may not be
connected).

| Adobe Flash Flayer Settings
Camera and Microphone Access @
eleamning.cambridgeinstitute net is
reguesting access to your camera and

miorophone. If you did Allow, you may
be recorded.

B O Aw B oy

Subsequently, a message at the top where Chrome will warn you that ‘http://
elearning.cambridgeinstitute.net wants to use your camera’, will appear.
You must click ‘Allow’.

€ - C' |[} elearning.cambridgeinstitute.net/course/mod/quiz/attempt.php?attempt=832456

B4 http://elearning.cambridgeinstitute.net/ wants to use your camera. Learn more | Deny ||| Allow
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Then, reload the browser page by clicking or pressing

All this can also be done in advance in Chrome.

or ‘CTRL + R’.

The first step is to click on the browser icon located in the

top-right of the window. In the dropdown ‘Menu’ you must

click on na ‘Settings’.

==

New tab

New window

Edit Cut  Copy  Paste

Zoom - 100% +

Sign in to Chrome...

Once inside, in the ‘Privacy’ section click ‘Content settings...’.

Chrome

Settings

Privacy

| Contentsettings... || Clear browsing data.. |

Google Chrome may use web services to imprave your browsing experience. You may optionally disable these

services, Learn more

¥ Use a web service to help resolve navigation errors

Again, once inside the ‘Media’ section you can check that everything is in

order.

Content settings

Media
Microphone: Microphone (Realtek ¥
Camera: -

! Do not allow sites to access your camera and microphone

| Manage exceptions... i

'® Ask when a site requires access to your camera and microphone [recommended)

10
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I’m trying to do my ‘Speaking’ exercises but it is not allowing
me to do so, what can I do?

In that case, you must clear the cache of your regular web browser, so the
browser is forced to load the latest versions of web pages. Then, we indicate
how to do it in different browsers.

Chrome:
You must click on the browser icon located in the top right of the window =

In the dropdown menu you must click on ‘More tools’ and ‘Clear browsing
data...” in the submenu that appears.

MNew tab

Mew window

New incognite window  Ctris
Bookmarks 3

Recent Tabs 3
Edit Cut Copy Paste

Save page 5.
Find...
Print...

Zoom - 10% -+ e

History

Downloads Ctrl+)
Sign in to Chrome...

Settings
About Google Chrome

Create application shertcuts... More tools

Extensions

iew source

11
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In the popup window, you must delete the stored items from ‘the last 4 week’
and mark the first four fields before clicking on ‘Clear browsing data’.

Clear browsing data

Psst! Incognito mode (Ctrl+Shift+MN) may come in handy next time.

Obliterate the following items from

| the last 4 weeks - ||

|| Browsing history

¥ Downlead history

3]

| Cookies and other site and plug-in data

| Cached images and files

|_| Passwaords

|| Autofill form data

Hosted app data

Learn mare

Clear browsing data

| Cancel |

Saved content settings and search engines will not be cleared and may reflect your

browsing habits,

Mozilla Firefox:

In the upper right corner of the window, click onthe g 3 & »- «- - [E

Firefox button and select ‘Options’.

Cortar Copiar
- 100%
Mueva venta-  Mueva venta-
na na privada
Imprimir Historial
Buscar Opciones

Y

Desarrollador

Personalizar

|
Pegar |

+

Guardar pagi-
na

©»

Pantalla com-
pleta

&

Complemen-
tos

| €2 ricardoroqueromateo@gmail.com

e o

12
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Once inside, select the tab or panel called ‘Advanced’.
rOpﬁons M‘
d & & & & 8 Qe

General Tabs Content  Applications  Privacy  Security Sync Advanced

General ‘ Data Choicesl Ne‘morkl Upd.atel Certific,at5|

Accessibility
[] Always use the cursor keys to navigate within pages
[7] Search for text when I start typing

[] Warn me when websites try to redirect or reload the page

Browsing

Use autoscrolling

Use smooth scrolling

Use hardware acceleration when available
Check my spelling as [ type

System Defaults i
Always check to see if Firefox is the default browser on startup

IMake Firefox the default browser

o) [ome ] [

L

Then, click on the tab called ‘Network’ and in ‘Cached Web Content’ within
the ‘Clear Now’ section. Then, click ‘OK’ and restart your browser.

-
Cptions

General Tabs Content  Applications  Privacy  Security Sync Advanced

GenErBtI Data Chmcesl MNetwerk | UpdatElCertiﬁcatac|

Cennection
Configure how Firefox connects to the Internet
Cached Web Content

Yourweb content cache is currently using 347 MB of disk space

[] Override automatic cache management

Limit cache to [ 35015 MB of space

Offline Web Content and User Data

Your application cache is currently using 0 bytes of disk space

Tell me when a website asks to store data for offline use

The following websites are allowed to store data for offline use:

Remove...

[ e | mrree—

13



=& CAMBRIDGE
INSTITUTE

Education Development for a Global Experience

DISTANCE LEARNING PLATFORMS
FAQs (FREQUENTLY ASKED QUESTIONS)

Internet Explorer version 9, 10y 11:

In the upper right corner of the window, click on the ‘Tools’ button and on
‘Safety’. In the dropdown submenu which appears click on ‘Delete browsing

history...".

+T11___ (Gmail
Delete browsing history... Ctrl+Shift+Del
InPrivate Browsing Ctrl+Shift+P

Turn on Tracking Protection
Turn off Do Mot Track requests
ActiveX Filtering

Webpage privacy policy...
Check this website

Turn off SmartScreen Filter...

Report unsafe website

Print

File »
Zoom (100%) 3
Safety 4

Add site to Start menu

View downloads Ctrl+]
Manage add-ons

F12 Developer Tools

Go to pinned sites

Compatibility View settings

Report website problems

Internet options

About Internet Explorer

In ‘Delete Browsing History’, uncheck
‘Preserve Favorites website data’ and
keep 'Temporary Internet files and
website files’ and ‘Cookies and website
data’, checked before pressing the button
‘Delete’.

'

™ )
Delete Browsing History M

Prﬁerve Favorites website data

Keep cookies and temporary Internet files that enable your favorite
websites to retain preferences and display faster.

empnra ry Internet files and website files
Copies of webpages, images, and media that are saved for faster
viewing.

ookies and website data

Files or databases stored on your computer by websites to save
preferences or improve website performance.

|:| History
List of websites you have visited.

["] Download History
List of files you have downloaded.

7] Form data
Saved information that you have typed into forms.

[l rasswords
Saved passwords that are automatically filed in when you sign in
to a website you've previously visited.

[ Tracking Protection, ActiveX Filtering and Do Not Track
A list of websites exduded from filtering, data used by Tracking

Protection to detect where sites might automatically be sharing details

about your visit, and exceptions to Do Mot Track requests.

About deleting browsing history [ Delete ] [ Cancel

l

14



*# CAMBRIDGE
INSTITUTE

Education Development for a Global Experience

DISTANCE LEARNING PLATFORMS

FAQs (FREQUENTLY ASKED QUESTIONS)

Safari (Mac OS):

In the Safari menu click on ‘Safari’ and click on ‘Private Browsing...” within
the drop-down menu.

[ 'File Edit View History
© © About Safari |
- Safari Extensions...

Preferences... 38, |

Private Browsing...
Reset Safari...

Services >
Hide Safari ¥H
Hide Others H®H
Show All

Quit Safari $£0

Then, in the popup window, select a time frame and click on ‘OK’.

Do you want to turn on Private Browsing?
Safari can keep your browsing history private. When
you turn on private browsing, Safari doesn't

remember the pages you wvisit, your search history, or
your AutoFill information.

@ | Cancel ]l@—m—dl

To finish cleaning Safari’s cache, click on the reload button &

000 Failed to open page "
<» g + |B google.com ¢ |gReader

15
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I am still having problems with recordings, what can 1 do?

Another thing you can do is to use a different browser and make sure you have

Flash Player version 10.1 or higher, it is recommended to have it updated.

You can check your version of Flash Player in:

http://helpx.adobe.com/flash-player.html

Visit the following link for solving basic problems related to Java:
http://www.java.com/en/download/help/troubleshoot_java.xml#versios

Delete old versions of Java and restart your computer:

http://www.java.com/en/download/fag/remove_olderversions.xml

Also, when exercising, be sure to use a headset and that speakers are
disconnected, since they cannot be both connected simultaneously.

What language should I use to make queries?
All communication must be conducted in English.

How do | contact the tutor?

Through the online chat.

Once you click on the Chat Online, banner, a popup window should appear
in which you should only fill in the fields and then click on the ‘Chat’ button.

16
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And select the option ‘departamento’ within the ‘Curso Espafol’ section:

& https://www.mylivechat.com/chat/

Live Chat

Gracias por contactar con nosotros. Para servirle mejor, por favor
proporcione la siguiente informacion:

nombre:

Email:

pregunta:

departamento: v

Evaluation system

The evaluation system is the sum of all units divided by the total number of
units and multiplied by 0.5, plus the sum of the total test score multiplied by
0.5.

Within your course, you need to click on ‘Grades’, which is located in the right
side of the screen, under ‘Course administration’.

Administration =

¥ Course administration

P My profile settings

17
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Does the online course have any time limit? What is the
deadline to complete my course?

You have limited access to the course, which is specified in the welcome
email sent on the first day of your course, which contains also your passwords
and starting and ending dates of the course. Frames can be:

e 3 months

e 6 months

¢ 9 months

e 12 months

¢ 18 months

The ending date of my course is approaching and 1 still have
much to do, how can | apply for an extension of time?

Regardless of the reason, a period of no more than 30 days shall be
deemed. For this application, you must write to the following email address:
tutoriasonline@cambridgeinstitute.net

Once this period is over, new extensions will not be granted.

What kind of certificate is given? Do I need to take an exam
to be certified?

A certificate issued by Cambridge Institute is always given if the average of
the entire course and the final exam exceed 60%o (in case of examination
in the course). If the course has no final exam, a certificate will be issued if
the average of the entire course exceeds 60%.

18
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I have finished my course, how do I request my certificate?
Please, access the link:
http://gestion.cambridgeinstitute.net/ecom-certificate/index.php?id=3

Follow instructions given.

CAMBRIDGE INSTITUTE

?;&j//'(m? : / ‘@//;ééé'ﬂ/z

This certifies that

Juanito Pérez
Soto-Montoya

Is the certificate equivalent to PET, First or Advanced?

No, for a PET, First or Advanced certificate you must present yourself to the
official Cambridge ESOL international exams.

19
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Suggestions

How do I enable cookies in Chrome browser?

You must click on the browser icon located in the top
right of the window and on ‘Settings’ in the drop-down

Mew tab

en u ’ Mew window
Mew incognito window  Ctrl+Shift+ N
Bookmarks 3
Recent Tabs [3
Edit Cut Copy Paste
Save page as... Ctrl+5
Find... Ctrl+F
Print... Ctrl+P
Zoom - 100% + i
History Ctrl+H
Downloads Ctrl+l

Sign in to Chrome...

About Google Chrome

Click on ‘Content settings’ within ‘Privacy’.

Chrome Settings

Privacy

EESE S Bl

Settings
I 7 Google Chrome may use web services to improve your browsing experience. You may optionally disable these

services, Learn more

About - 5
W] Use 3 web service to help resolve navigation errors

Once inside the ‘Cookies’ section mark ‘Allow local data to be set
(recommended)’.

Content settings

Cookies

- Allow local data to be set (recommended)

| Keep local data only until you quit your browser
' Block sites from setting any data

[ Block third-party cockies and site data

I Manage exceptions.., “ All cookies and site data. |

20
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Furthermore, you can click on ‘Manage exceptions...’. Simply press the button
at the bottom of the previous image and enter the address of Cambridge
Institute in ‘Hostname pattern’.

http://elerning.cambridgeinstitute.net/course/login

Cookie and site data exceptions

Hostname pattern Behavior
http://elemning.cambridgeinstitute.net Allow
[*]example.com Allow >

Finally, you need to click on ‘Done’ and restart Chrome.

21
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How do I enable cookies in Firefox?

Although Firefox cookies are enabled by default, you can always check and
modify settings if necessary.

We begin by clicking on the top right corner of the window.
Click on the Firefox button and select ‘Options’.

Cut Copy Paste
- 100% +
Mew Window  New Private Save Page
Window
e
= O ©
—
Print History Full Screen
Find Options Add-ons
Developer

€ Signinto Sync

Customize o c}

Once inside, select the tab or panel ‘Privacy’.

'Dpﬁons MW
0w & a8 Q@ %

General Tabs Content  Applications = Privacy  Security Sync Advanced

Tracking

(71 Tell sites that [ do not want to be tracked

() Tell sites that I want to be tracked

@ Dg not tell sites anything about my tracking preferences

Learn More

History

Firefox will: | Remember history =

Firefox will remember your browsing, download, form and search history, and
keep cookies from websites you visit,

You may want to clear your recent histery, or remove individual cookies.

Location Bar

When using the location bar, suggest | History and Bookmarks ~

[ oK H e ]l Help ]

22
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In the section called ‘History’, click on ‘Firefox will’ and mark ‘Use custom
settings for history’.

Irf)pt:icms ﬂ‘
0o & @ #=a O

General Tabs Content  Applications ~ Privacy  Security Sync  Advanced

Tracking
() Tell sites that I do not want to be tracked

(71 Tell sites that I want to be tracked

@ De not tell sites anything about my tracking preferences

Learn More

History

Firefox will: | Rem

Rem

Never remember history

Use custom settings for history
Firefox will remember your browsing, download, form and search history, and

keep cookies from websites you visit.

You may want to clear your recent histary, or remove individual cookies.

Location Bar

When using the location bar, suggest: | History and Bookmarks =

[ o H G ]l Help ]

Once inside, unmark the option called ‘Always use private browsing
mode’ and select these ‘Remember my browsing and download history’,
‘Remember search and form history’ and ‘Accept cookies from sites’.

Moreover, make sure that the option called ‘Accept third-party cookies’
does not contain the value ‘Never’. You have two options in ‘Keep until’:

— ‘they expire’: cookies will be deleted when they reach expiration date.
- ‘I close Firefox’: cookies will be deleted when Firefox is closed.

Do not mark third option: ‘Ask me every time’.

23
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[ Cptions g“
d &= 4

General Tabs Content  Applications ~ Privacy  Security Sync Advanced

Tracking

() Tell sites that [ do not want to be tracked

(71 Tell sites that I want to be tracked

@ Do not tell sites anything about my tracking preferences

Learn More

History

Firefox will: l Use custom settings for history =

[7] Ahways use private browsing mode

Remember my browsing and download history

Remember search and form history

Accept cookies from sites

Accept third-party cookies:
Keep until: Show Cookies...

[7] Clear history when Firefox closes Settings...

Location Bar

When using the location bar, suggest: | History and Bookmarks =

Next, click on ‘Exceptions...".

rOpﬁnns ﬂ-‘
O &= 2 QO U

oy
General Tabs Content  Applications = Privacy  Security Sync Advanced

Tracking

() Tell sites that I do not want to be tracked

(71 Tell sites that I want to be tracked

@ Do not tell sites anything about my tracking preferences

Learn More

History

Firefox will: l Use custom settings for history =

[T] Always use private browsing mode

Remember my browsing and download history

Remember search and form history

V| Accept cookies from sites

Accept third-party cookies:
Keep until: | they expire b Show Cookies...

[T Clear history when Firefox closes Settings...

Location Bar

When using the location bar, suggest: | History and Bookmarks =

[ oK H it H Help I
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Once inside ‘Exceptions’ enter the URL for accessing the course in the field
‘Address of website’:

http://elerning.cambridgeinstitute.net/course/login

r B
@ Exceptions - Cookies L |l g

You can specify which websites are always or never allowed to use cookies,
Type the exact address of the site you want to manage and then click Block,
Allow for Session, or Allow,

Address of website:

|http://elerning.cambridgeinstitute.net/course/| ogin-l_

’ Block ][Atlowfosgﬂsionll Allow i

Site Status

Remove Site : Remaovwe All Sites : Cloze

L 4

Finally click on ‘Allow’ and ‘Close’ buttons, then click on ‘OK” within the
‘Privacy’ section, which remained open, and restart Firefox.
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How do | enable cookies in Internet Explorer?

Start by marking ‘Settings’ # in Internet Explorer, it is in the upper right
part of the window, and then ‘Internet options’.

Print

File

Zoom (100%:)
Safety

* v v ¥

Add site to Start menu

View downloads Ctrl+J
Manage add-ons

F12 Developer Tools

Go to pinned sites

Compatibility View settings

Report website problems

Internet options

Then, click on the ‘Privacy’ tab and move the slider to the level of privacy you
want, we recommend ‘Medium’. (as you scroll the slider, Internet Explorer
will offer you a description of the types of cookies that will be blocked and
allowed at each level of privacy).

g P s
Internet Options m

General I Security | Privacy |Conhent | Connections | Programs I advanced|

Settings

Select a setting for the Internet zone.
- Blocks third-party cookies that do not have a compact
privacy policy

- Blocks third-party cookies that save information that can
) be used to contact you without your explicit consent

- Restricts first-party cookies that save information that
can be used to contact you without your implicit consent

[ Sites. ] [ Import ] [ Advanced ] Default
Location

Never allow websites to request your
O physical location Clear Sites
Pop-up Blocker
Turn on Pop-up Blocker Settings
InPrivate

Disable toolbars and extensions when InPrivate Browsing starts
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In addition, press ‘Settings’ and once inside, add the Cambridge Institutes
URL within the field that displays the image:

http://elerning.cambridgeinstitute.net/course/login

7 W
Internet Options m

| General I Security | Privacy | Content I Connections I Programs I Advanced | rPup-up Blocker Settings g‘
Settings Exceptions
Select a setting for the Internet zone, Pop-ups are cumently blocked. You can allow pop-ups from specfic
Medium ; !l websites by adding the site to the list below.
- Blocks third-party cookies that do not have a compact Address of website to allow:
privacy policy http://eleaming cambridgeinstitute net/course-login i l
- Blocks third-party cookies that save information that can I £ < g g I dd
) be used to contact you without your explicit consent
- Restricts first-party cookies that save information that Allowed sites
can be used to contact you without your implict consent o
i . -F!.EI'GDVE ali..
[ Sites ] [ Import ] [ Advanced ] | Default
Location
Mever allow websites to request your
O physical location HATS
Pop-up Blocker
S Notifications and blocking level:
N fclfipes [/] Play a sound when & pop-up is blocked
InPrivate Show Motification bar when a pop-up is blocked
[7] Disable toolbars and extensions when InPrivate Browsing starts Blocking level:
[Madm Block most automatic pop-ups ']
Leam more about Pop-up Blocker Close
L y

Finally, click on ‘OK” and ‘Apply’, before restarting Internet Explorer.

I B
Internet Opticns m

| General | Security ‘ Privacy |Cantent | Connections | Programs I Advancedl

Settings

Select a setting for the Internet zone.
Medium

- Blocks third-party cookies that do not have & compact

privacy policy

- Blocks third-party cockies that save information that can
) be used to contact you without your explicit consent

- Restricts first-party cookies that save information that

can be used to contact you without your implicit consent

[ stes ][ import | [ Advanced || Defaut
Location
Mever allow websites to request your
D physical location ar sies
Pop-up Blocker
Turn on Pop-up Blocker
InPrivate

Disable toolbars and extensions when InPrivate Browsing starts

Lo J|[Cence J[_somy ]
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How do | enable cookies in Safari (Mac OS)?

In the Safari menu click on ‘Safari’ and click on ‘Preferences...” within the
drop-down menu.

@ ® About Safari
Safari Extensions...

. & BTN File  Edit  View,
=

Preferences... %8,

Private Browsing...
Reset Safari...

Services >
Hide Safari ¥H
Hide Others N ¥EH
Show All
Quit Safari $Q
Select the ‘Privacy’ tab.
0606 Privacy

Cookies and other website data: [ Remove All Website Data... ]

59 websites stored cookies or other data [ Details... |

Block cookies and other website data: () From third parties and advertisers
() Always

(*) Never

Limit website access to location services: (®) Prompt for each website once each day
() Prompt for each website one time only
() Deny without prompting

Website tracking: [ | Ask websites not to track me

Smart Search Field: | | Do not preload Top Hit in the background
|| Prevent search engine from providing suggestions

®
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Once inside, in the section called ‘Block cookies and other website data’,
mark ‘Never’ and leave the other options as shown in the following image

@00 . . Privacy

Cookies and other website data: [ Remove All Website Data... ]
59 websites stored cookies or other data | Details... ]

Block cookies and other website data: () From third parties and advertisers
() Always

Limit website access to location services: (®) Prompt for each website once each day
() Prompt for each website one time only
() Deny without prompting

Website tracking: [ | Ask websites not to track me

Smart Search Field: [_| Do not preload Top Hit in the background
|| Prevent search engine from providing suggestions ®

Finally, click on the reload button & in Safari.

i File Edit View

eee Failed to open page )
> !g + |B google.com ¢ |gReades

For technical questions not mentioned in this manual, you can always contact
Cambridge Institute through this email address:

tutoriasonline@cambridgeinstitute.net
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